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Documentation Updates

This guide’s title page contains the following identifying information:

• Software Version number, which indicates the software version.

• Document Release Date, which changes each time the document is updated.

• Software Release Date, which indicates the release date of this version of the software.

To check for recent updates, or to verify that you are using the most recent edition of a document, go to:

http://h20230.www2.hp.com/selfsolve/manuals 

This site requires that you register for an HP Passport and sign-in. To register for an HP Passport ID, go to: 

http://h20229.www2.hp.com/passport-registration.html 

Or click the New users - please register link on the HP Passport login page.

You will also receive updated or new editions if you subscribe to the appropriate product support service. 
Contact your HP sales representative for details.
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Support

You can visit the HP Software Support Online web site at:

http://www.hp.com/go/hpsoftwaresupport

This web site provides contact information and details about the products, services, and support that HP 
Software offers.

HP Software Support Online provides customer self-solve capabilities. It provides a fast and efficient way to 
access interactive technical support tools needed to manage your business. As a valued support customer, you 
can benefit by using the HP Software Support web site to:

• Search for knowledge documents of interest

• Submit and track support cases and enhancement requests

• Download software patches

• Manage support contracts

• Look up HP support contacts

• Review information about available services

• Enter into discussions with other software customers

• Research and register for software training

Most of the support areas require that you register as an HP Passport user and sign in. Many also require a 
support contract.

To find more information about access levels, go to:

http://h20230.www2.hp.com/new_access_levels.jsp 

To register for an HP Passport ID, go to:

http://h20229.www2.hp.com/passport-registration.html
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1 Overview
OVO/HPOM Message Generation

On a high level, OVO/HPOM generates messages in the following way:

1 An event occurs on a managed object. The managed object creates a message.

2 The OVO/HPOM agent on the managed node receives the message.

3 The message is compared to filters. Messages matching suppress conditions or duplicate 
messages are suppressed. Other messages are forwarded.

4 The message is logged locally.

5 Messages that match filters are converted to the OVO/HPOM message format, and 
forwarded to the management server.

6 The management server processes the message by taking one of the following actions:

• Assigns the message to another message group (regrouping).

• Starts non-local actions configured for the message on the specified node.

• Forwards the message to external notification interfaces and trouble ticket service.

• Escalates the message to another preconfigured management server.

• Buffers the message in the Pending Message Browser.

7 The active message is stored in the database.

8 The message is displayed in a Message Browser window.

9 When the message is acknowledged, it is removed from the active browser and put into 
the history database.
9



Active Messages

• They are messages that have not been acknowledged by an OVO/HPOM operator.

• They display in the OVO/HPOM Message Browser.

• For OVO for UNIX/HPOM for UNIX, they reside in the opc_act_messages table.

• For OVO for Windows/HPOM for Windows, they reside in the OV_MS_Message table. 

History Messages

• They are messages that have been acknowledged.

• OVO for UNIX/HPOM for UNIX history messages are stored in the opc_hist_messages 
table for historical analysis.

• OVO for Windows/HPOM for Windows history messages are stored in the 
OV_MS_Message table. 

Message Groups

A message group is a convenient way to categorize messages. Messages belonging to the same 
function or task can be collected into a single group. For example, the message group Backup 
can contain all messages that relate to the backing up and storing of data (for example, 
messages originating from a network backup program, pieces of hardware used in the backup 
or storage operation, and so on). Message groups are then assigned to operators, who see and 
manage only those groups assigned to them. 

Applications

An application can be a program, command, script, utility or service that the operator uses to 
maintain and control system and network services. For example, a backup program, and the 
process status command ps, can be integrated as applications.

OVO for Windows/HPOM for Windows history messages also reside in this table. A field state 
indicates if the message is active or history. Active messages have a state of 1, 2, or 3. History 
messages have a state of 4 or 5.

OVO for Windows/HPOM for Windows active messages also reside in this table. A field state 
indicates if the message is active or history. Active messages have a state of 1, 2, or 3. History 
messages have a state of 4 or 5.
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HP Performance Insight

Performance Insight collects data from many sources, performs in-depth trend analysis, 
maintains performance baselines, and provides users with convenient, web-based reporting. 
Following is a partial list of product features:

• Distributed architecture

• Easy to scale (supports data collection from thousands of agents)

• CODA/PA agent support

• Multi-company security model

• Data warehousing

• Near Real Time reporting

• Forecasting 

• Location Independent Reporting (LIR)

• Archiving via Long Term Retention (LTR)

• Multiple aggregation options (by hour, day, week, month; by location, by customer)

• Thresholding and alerting

• Easy identification of bottlenecks via top-10 ranking

• Easy identification of capacity trends

• Accurate and timely documentation for management

• Integration with Network Node Manager (NNM)

• Integration with OpenView Operations (OVO)

The reporting solutions created for Performance Insight cover many areas of business 
technology optimization. For details, see Appendix B, PI Report Packs.
Overview 11



OVO Report Pack

The OVO Report Pack processes the following data from one or multiple OVO/HPOM servers:

• Message patterns based on OVO/HPOM Active message tables

• Message patterns based on OVO/HPOM History message tables

• Service status based on the OVO/HPOM Service Log table

The OVO Report Pack maintains the following data sets:

• Active Messages (currently unacknowledged messages)

• Active + History Messages (consolidated message reporting)

• Service Log

• Configuration

Each data set has four summary tables and four reporting views.

The OVO Report Pack offers the following features:

• Multiple groups and roll-up combinations for:

— All OVO/HPOM servers

— Node and Application

— Node and Template

— Server and Service

• Server configuration reporting

• Template and condition reporting

Enhancements in Version 1.41

Version 1.41 of the report pack includes new features and new upgrade packages.

• OVO_Upgrade_to_141.ap

• OVO_Datapipe_Upgrade_to_14.ap (to upgrade RNS 12.0 or RNS 13.0 to RNS 14.0)

• OVO_Datapipe_Upgrade_14_to_141.ap (to upgrade RNS 14.0 to RNS 14.1)

• Support for HPOM 9.0 for Windows, HP-UX, Solaris, and Linux operating systems.

You can not upgrade OVO_Datapipe to version 1.41 (RNS 14.1) directly from version 1.2 (RNS 
12.0) or 1.3 (RNS 13.0)

To upgrade to 1.41, follow these steps:

1 Launch Package Manager.
2 Install OVO_Datapipe_Upgrade_to_14.ap to upgrade from OVO_Datapipe version 1.2 

or 1.3 to OVO_Datapipe version 1.4. 
3 Relaunch Package Manager.
4 Install OVO_Datapipe_Upgrade_14_to_141.ap to upgrade from OVO_Datapipe version 

1.4 to OVO_Datapipe version 1.41
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Folders and Reports

OVO reports show summarized statistics or data and the message count is the average 
message count on hourly, daily, weekly, or monthly basis. This message count might not 
reflect the real time message count on any particular time period.

Installing the OVO Report Pack deploys the following report folders and reports:

Folder Contents

Active (14) • Message Severity by All Messages Trend
• Message Severity by Application Trend
• Message Severity by Message Group Trend
• Message Severity by Node and Service Trend
• Message Severity by Server
• Message Severity by Server and Application
• Message Severity by Server and Message Group Trend
• Message Severity by Server and Node Trend
• Message Severity by Server and Service Trend
• Message Severity by Server, Node, and Application Trend
• Message Severity by Server, Node, and Message Group Trend
• Message Severity by Server, Node, and Service Trend
• Message Severity by Service Trend
• OVO/OM Server Summary

Message Weekly (3) • Weekly History Dashboard by Template
• Weekly History Dashboard by Template and Condition
• Last Week Dashboard by Server and Template

Config (2) • Notif Channels 
• Trouble Ticket Channels 
Overview 13



Message (30) • History Dashboard by Server and Node
• History Dashboard by Server Node and Template
• Message Age Severity by Server and User Trend
• Message OVO/OM Server Summary
• Message Severity by All Messages Trend
• Message Severity by Application Trend
• Message Severity by Message Group Trend
• Message Severity by Node Trend
• Message Severity by Node and Application Trend
• Message Severity by Node and Message Group Trend
• Message Severity by Node and Template Trend
• Message Severity by Node and Service Trend
• Message Severity by Server Trend
• Message Severity by Server and Application Trend
• Message Severity by Server and Message Group Trend
• Message Severity by Server and Node Trend
• Message Severity by Server and Service Trend
• Message Severity by Server and Template Trend
• Message Severity by Server and User Trend
• Message Severity by Server, Node, and Application Trend
• Message Severity by Server, Node, and Message Group Trend
• Message Severity by Server, Node, and Service Trend
• Message Severity by Server, Template and Condition Trend
• Message Severity by Service Trend
• Message Severity by Template Trend
• Message Severity by Template and Condition Trend
• Message Severity by User Trend
• Monthly Server Breakdown with Special Flags
• Server Breakdown with Special Flags
• Template Breakdown with Special Flags

OVO9 (6) This folder contains the reports for HPOM 9.0
• Weekly:

• Weekly History Dashboard by Server and Template

• Weekly History Dashboard by Template

• History Dashboard by Server Node and Template
• Message Severity by Message Template
• Message Severity by Template Trend 
• Template Breakdown with Special Flags

Service Log (1) • Severity Trend (Daily messages by services, by severity, and 
duration details daily, weekly, and monthly)

Folder Contents
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Metrics Not Available from OVO for Windows/HPOM for 
Windows

The following metrics are collected from OVO for UNIX/HPOM for UNIX only:

• ESCALATE_FLAG

• IP_ADDRESS

• NOTIFY_SERVICES

• STATUS_FLAG

• TEMPLATE_DESCRIPTION

The lack of these metrics has an impact on certain reports. If you are looking at an Active/
History Message report, the value in the Escalate field will always be zero. The following table 
lists the specific reports affected: 

 

The templates/policies and conditions have changed for HPOM 9.0 and are no longer 
available for reporting. Therefore, the HPOM 9.0 reports are based on message source type 
instead of templates. For a list of available message types in HPOM 9.0, see Appendix C, 
Message Types for HPOM 9.0.

You can still can use all the existing template and conditional reports available in the 
Message folder. But these reports consider that there is no specific template and all the 
messages are instances of unknown template. Conditional description is no longer possible 
and is not available for reporting on HPOM 9.0. 

Folder Reports with Escalate field always zero

Active • Message Severity by All Messages Trend
• Message Severity by Application Trend
• Message Severity by Message Group Trend
• Message Severity by Node and Service Trend
• Message Severity by Server
• Message Severity by Server and Application
• Message Severity by Server and Message Group Trend
• Message Severity by Server and Node Trend
• Message Severity by Server and Service Trend
• Message Severity by Server, Node, and Application Trend
• Message Severity by Server, Node, and Message Group Trend
• Message Severity by Server, Node, and Service Trend
• Message Severity by Service Trend
• OVO/OM Server Summary
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If you are looking at the Monthly Server Breakdown with Special Flags, Server Breakdown 
with Special Flags, or Template Breakdown with Special Flags, the following fields will 
always be zero:

• TT only

• Notify only

• TT & Notify only

Sources for Additional Information

The demo package that comes with OVO Reporting contains a sample of each report in the 
package. If you have access to the demo package and you want to know what fully-populated 
reports look like, install the demo package. Like real reports, demo reports are interactive. 
Unlike real reports, the data in a demo report is static.

For details about known issues and recent enhancements, see OVO Reporting 1.41 Release 
Notes. Manuals for the HP Performance Insight software and manuals for the reporting 
solutions that run on the HP Performance Insight software can be downloaded from the 
following site:

http://h20230.www2.hp.com/selfsolve/manuals

The user guides for PI are listed under Performance Insight. The user guides for report packs 
and datapipes are listed under Performance Insight Report Packs. Each manual indicates a 
date. If a manual is revised and reposted, the date will change. Revised manuals are posted on 
a regular basis, so make sure to compare your PDF to the PDF on the web and use the web 
version if it is newer.

Message • History Dashboard by Server and Node
• History Dashboard by Server Node and Template
• Message OVO Server Summary
• Message Severity by All Messages Trend
• Message Severity by Application Trend
• Message Severity by Message Group Trend
• Message Severity by Server Trend
• Message Severity by Server and Application Trend
• Message Severity by Server and Message Group Trend
• Message Severity by Server and Node Trend
• Message Severity by Server and Service Trend
• Message Severity by Server and User Trend
• Message Severity by Server, Node, and Application Trend
• Message Severity by Server, Node, and Message Group Trend
• Message Severity by Server, Node, and Service Trend
• Message Severity by Service Trend
• Message Severity by Template Trend
• Message Severity by User Trend

Folder Reports with Escalate field always zero
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2 Install and Configuration
Guidelines for Install/Upgrade

A PI reporting solution has two ingredients, a report pack and a datapipe. Some reporting 
solutions include multiple datapipes. When you install the datapipe, you configure PI to 
collect a specific type of performance data at a specific interval. When you install the report 
pack, you configure PI to summarize and aggregate the data collected by the datapipe.

The report pack CD contains report packs, datapipes, shared packages, and documentation. If 
you extracted packages from the CD, every package, including the OVO Report Pack and the 
OVO Datapipe, was copied to the Packages directory on your system and is now ready to 
install. Your next step is to launch Package Manager and follow the on-screen instructions. 

If you did not extract packages from the report pack CD, do that now. The procedure is 
explained on page 20. Extracting packages to the Packages directory launches Package 
Manager. Before using Package Manager to install OVO Reporting, make sure that the 
prerequisites for OVO Reporting have been satisfied.

Supported Environments

The OVO Report Pack is designed to operate in the following environment:

Common Property Tables

If you are running an older version of Common Property Tables, you must upgrade to version 
3.91 by installing the upgrade package CommonPropertyTables_Upgrade_to_391. If you are 
not running any version of Common Property Tables, Package Manager will install the latest 
version of Common Property Tables for you, automatically.

When you upgrade Common Property Tables, do not install the upgrade package and other 
packages at the same time. Instead, install the upgrade package for Common Property Tables 
and nothing else. Once Common Property Tables is upgraded, restart Package Manager and 
install more packages. For more information about Common Property Tables, see the 
Common Property Tables 3.91 User Guide.

Upgrading to Version 1.41

To upgrade, perform the following steps:

1 Make sure that you have the latest version of Common Property Tables (version 3.91) 
installed. If not, upgrade to version 3.91.

PI Version Oracle Sybase

5.41 10g 15.0.2
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2 Uninstall the previous version of the OVO Datapipe.

3 Launch Package Manager and install the following packages in the given sequence:

a OVO_Reporting_Upgrade_to_141

b OVO_Datapipe_Upgrade_to_14

c OVO_Datapipe_Upgrade_14_to_141

Using Package Manager to Install OVO Reporting

This section explains how to install OVO Reporting fresh, for the first time. It covers the 
following tasks:

• Task 1: Extract packages from the report pack CD

• Task 2: If necessary, upgrade Common Property Tables

• Task 3: Start Package Manager and install the following packages:

— OVO Reporting 1.41

— OVO Datapipe 1.41

Task 1: Extract packages from the report pack CD

1 Log on to the system. On UNIX systems, log on as root.

2 Stop the PI Timer and wait for processes to terminate.

Windows: Select Settings → Control Panel → Administrative Tools → Services.

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Solaris and Linux: sh /etc/init.d/ovpi_timer stop

3 Insert the report pack CD in the CD-ROM drive. On Windows, a Main Menu is displayed 
automatically. On UNIX, mount the CD, navigate to the top-level directory for the CD 
drive, and type the setup command. 

4 Select PI report packs by typing 1 in the choice field and pressing Enter. The install script 
displays a percentage complete bar. When the extraction finishes, the install script starts 
Package Manager. The Package Manager welcome window opens.

If you navigate to the Packages directory on your system, you will see the following directory 
structure:

{DPIPE_HOME}/packages/OVO_Reporting/OVO.ap

{DPIPE_HOME}/packages/OVO_Reporting/OVO_Demo.ap

{DPIPE_HOME}/packages/OVO_Reporting/OVO_Datapipe.ap

{DPIPE_HOME}/packages/UPGRADE_OVO_to_141.ap

{DPIPE_HOME}/packages/UPGRADE_OVO_Datapipe_to_14.ap

{DPIPE_HOME}/packages/UPGRADE_OVO_Datapipe_14_to_141.ap

If this is a new install, you can ignore the upgrade package. Installing the demo package is 
optional.
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Task 2: Upgrade to Common Property Tables 3.91

When performing this upgrade, observe the following rules:

• Do not install anything else. Install the upgrade package and only the upgrade package. 

• When prompted to accept or disable the option to Deploy Reports, accept the default. If 
you do not deploy reports, you will not get the forms.

• When the install finishes, click Done to return to the Management Console.

Task 3: Install the OVO/HPOM report pack and the OVO/HPOM datapipe

1 If Package Manager is not running, select Tools → Package Manager from the Management 
Console. The Package Manager welcome window opens.

2 Click Next. The Package Location window opens.

3 Click Install. Approve the default installation directory or use the browse feature to select 
a different directory if necessary. 

4 Click Next. The Report Deployment window opens. Accept the default for Deploy Reports, 
application server name, and port. Type your username and password for the PI 
Application Server. 

5 Click Next. The Package Selection window opens. 

6 Click the check box next to the following packages:

• OVO Reporting 1.41

• OVO_Datapipe 1.41

7 Click Next. The Type Discovery window opens. 

8 Disable the default to run Type Discovery immediately after package installation. 

9 Click Next. The Selection Summary window opens.

10 Click Install. The Installation Progress window opens and the install process begins. When 
the install finishes, a package install complete message appears. 

11 Click Done to return to the Management Console. 

12 Restart the PI Timer.

Windows: Select Settings → Control Panel → Administrative Tools → Services.

UNIX: As root, type one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Solaris and Linux: sh /etc/init.d/ovpi_timer start

OVO Reporting does not require Type Discovery. If you are installing other report 
packs in addition to OVO Reporting, you might need to run Type Discovery for 
those packages. 
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Configuration Steps

Once the report pack is installed, perform the following configuration steps related to the 
OVO/HPOM database:

• Enable the TCP/IP protocol on all HPOM for Windows 8.0 servers (applies to HPOM for 
Windows 8.0 servers only)

• Set Up a Connection to the OVO/HPOM database

• Register OVO/HPOM servers with the OVO Datapipe (add each system name to the .prp 
file)

• Configure OVO/HPOM for Active Message Export

Task 1: Open the TCP/IP Protocol on the HPOM for Windows Server (applies to HPOM for Windows 8.0 only)

1 Select Start → All Programs → Microsoft SQL Server 2005 → Configuration Tools → SQL Server 
configuration Manager.

2 The SQL Server Configuration Manager window opens.

3 Select Protocols for OVOPS.

OVOPS is a database instance name. The name might be different in your 
environment.
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4  In the panel on the right, select TCP/IP.

5 The TCP/IP Properties window opens.

6 In the Protocol tab, opposite Enabled, select Yes. The TCP/IP protocol is now enabled.

7 Select the IP Addresses tab.
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8 Set all Active to Yes.

9 Set all Enabled to Yes.

10 Do not modify the IP Address field.

11 Set TCP Dynamic Ports to null.

12 Set the TCP port to any port number, ensuring no port conflict. An MS SQL server usually 
uses port 1433.

13 Click Apply to apply your changes.

14 Click OK to close pop-up window.

15 Restart the MS SQL service.

Task 2: Add an External OVO/HPOM Database to PI

The PI server cannot connect to the OVO/HPOM database unless it has the information it 
needs to make the connection. Supply this information by running the Add Database Wizard.

Perform the following steps to connect PI to the OVO/HPOM database:

1 Start the Management Console and log on as the PI administrator.

2 Click the Systems icon on the lower left. The System/Network Administration pane opens.
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3 Expand Databases node and click Add a Database Reference. The Add Database Wizard 
opens.  
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4 Click Next. The Type of Database window opens. 

5 Select Generic Supported Database and click Next.

6 In the Database Connectivity Information window, add information about the OVO/
HPOM database. 

For an OVO for UNIX/HPOM for UNIX Database:

d Hostname: IP address or hostname of the OVO for UNIX/HPOM for UNIX server

e Port: port the database is listening on

f Vendor: Oracle
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g Database Instance: SID of OVO/HPOM database

h Database Username: OVO/HPOM database log on. The user selected should have 
permission to acess OVO/HPOM tables and also have permission to create/drop views.

It is recommended to use opc_op user to connect to the OVO for UNIX/HPOM for 
UNIX database. 

i Password: OVO/HPOM database password for log on

For an OVO for Windows/HPOM for Windows Database:

a Port: the SQL Server port

b Vendor: SQLServer

c Windows Authentication: check this box (HPOM for Windows 8.0 only)

d Domain: the domain on the Windows account (HPOM for Windows 8.0 only)

e Window Username: the Windows account username. The Windows account username 
must have permission to access MS SQL Server Express (shipped with HPOM for 
Windows 8.0).

f Password: the Windows account password, not the database password

7 Click Next. The Identify System window opens. 

8 Type a name and a description. 

You can use the hostname or any name that is meaningful to you.

The name you specify appears in the <Name> field in the systems.xml file, and in 
reports. The OVO Datapipe uses the name you specify here to locate connectivity 
information for the OVO/HPOM database.

You also use this name in Task 3 on page 27.
Install and Configuration 25



9 Click Next. The Summary Page window opens.

10 Review the contents of the Summary Page and click Finish.
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11 Verify that the connection you just added is recognized by PI by selecting the new 
database in the System/Network Administration pane. Review the connectivity 
parameters.  

12 Click the Test Connection button to verify that PI can connect to the OVO/HPOM 
database.

Task 3: Register OVO/HPOM Servers with the OVO Datapipe

Add each system to the appropriate .prp file:

All the .prp files were added to the data directory when you installed the report pack. The 
OVO Datapipe uses the .prp file to determine which OVO/HPOM databases it will collect 
data from and how to connect to each database.

File Function

{DPIPE_HOME}/data/ovou9servers.prp List of HPOM for UNIX and Linux 9.0 
servers

{DPIPE_HOME}/data/ovow9servers.prp List of HPOM for Windows 9.0 servers

{DPIPE_HOME}/data/ovou8servers.prp List of OVO for UNIX 8.0 servers

{DPIPE_HOME}/data/ovow8servers.prp List of HPOM for Windows 8.0 servers

{DPIPE_HOME}/data/ovou7servers.prp List of OVO for UNIX 7.0 servers

{DPIPE_HOME}/data/ovow7servers.prp List of OVO for Windows 7.5 servers

{DPIPE_HOME}/data/systems.xml Connectivity details for each database
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Register each server by adding to the file one line for each OVO/HPOM server you want to 
collect from. If you are collecting from multiple servers, list each server on a separate line, 
using the system name you assigned. If you are collecting from a single OVO/HPOM server, 
the file will contain one line. No other information is allowed in this file. Do not insert 
comments or any other information.

Each name you add to this file must match the name you typed in the Identify System 
window. The OVO Datapipe uses these names to locate connectivity information in the 
systems.xml file. These names also appear in reports. 

Task 4: Configuring OVO/HPOM for Active Message Export

The OVO Datapipe does not export messages from the Active Message table. Instead, it takes 
a snapshot of current Active Message statistics and summarizes the results to hourly, daily, 
weekly, and monthly levels. The results are similar to HISTORY statistics. The difference is 
that taking a snapshot of current statistics produces a summary of “Current Active Messages” 
as compared to “New HISTORY”.

To make the snapshot of current Active Message statistics possible, you must create three 
separate export views on the OVO/HPOM database. The OVO Report Pack rollup generates 
additional levels of data from the data provided by the export views.

The following export views are created for the element level indicated:

OVPI_ACT_ONA: OVO_SERVER – NODE_NAME – APPLICATION

OVPI_ACT_ONS: OVO_SERVER – NODE_NAME – SERVICE_NAME 

OVPI_ACT_ONM: OVO_SERVER – NODE_NAME – MSG_GROUP

Until you create these views, current Active Message statistics are not exported from that 
OVO/HPOM server. Perform the following steps to create views:

1 Log on to the PI server as the PI administrator (trendadm on Unix).

2 Run the following command at the command line:

ovo_datapipe -dataset create_view –database <nsprod1> –server <u8>

The -database parameter takes the same system name that was defined when the 
database was added. For example, <nsprod1> is the same database name you provided in  
step 7 on page 25.

For each OVO/HPOM database listed in .prp file, four blocks of messages are printed on the 
command line. The messages indicate that SQL statements are being executed to create four 
table views in each OVO/HPOM database.

If the views fail to create, verify that you have permission to create and drop views.

You can check the OVO/HPOM database to see if the views are created sucessfully. If 
not, contact the database administrator for help.

You can also use the -d option to get more debug information.
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The Export Program

The OVO/HPOM export program connects to the OVO/HPOM database and exports 
information from Consolidated and Service Log tables. 

When the export process runs for the first time, it exports two days of data by default. You can 
get more days of data by specifying -prevdays parameter. See Export Program Parameters 
on page 30 for more information. 

When the export process runs for the second time, only new records since the last export are 
exported from the tables. 

The export process is driven by a PI trend_proc batch file. After installation, the file is located 
in the following location:

{DPIPE_HOME}/scripts/OVO_Datapipe_Hourly.pro

This file drives three separate export processes, one for each of the three required OVO/
HPOM datasets. The executable command for each dataset  is the following:

ovo_datapipe -dataset MSG

ovo_datapipe -dataset SRV_LOG

ovo_datapipe -dataset ACT

The name of the export program is ovo_datapipe. Although the program has several 
configurable parameters as the following table shows, in most cases only the -dataset 
parameter is needed. The following files contain the information that the ovo_datapipe export 
program requires to connect to each OVO/HPOM database:

If the -dataset option is the only option specified when the ovo_datapipe process is 
initiated, ovo_datapipe will collect data from every OVO/HPOM server listed in the OVO/
HPOM .prp files. The ovo_datapipe process uses the list of servers in the OVO/HPOM .prp 
files to locate connectivity information in the systems.xml file.

File Function

{DPIPE_HOME}/data/ovou9servers.prp List of HPOM for UNIX and Linux 9.0 
servers

{DPIPE_HOME}/data/ovow9servers.prp List of HPOM for Windows 9.0 servers

{DPIPE_HOME}/data/ovou8servers.prp List of OVO for UNIX 8.0 servers

{DPIPE_HOME}/data/ovow8servers.prp List of HPOM for Windows 8.0 servers

{DPIPE_HOME}/data/ovou7servers.prp List of OVO for UNIX 7.0 servers

{DPIPE_HOME}/data/ovow7servers.prp List of OVO for Windows 7.5 servers

{DPIPE_HOME}/data/systems.xml Connectivity details for each database
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Export Program Parameters

The OVO/HPOM export process is flexible. The following table describes each parameter.

The first time the export process runs, an excessive amount of data can be exported from the 
OVO/HPOM database if the process is allowed to go back too far to locate records to export. 
You can limit the amount of data that will be exported by configuring the OVO/HPOM 
datapipe to go back a specific number of days. If you do not specify a value for this parameter, 
the export adheres to the default, which is to export messages no older than midnight of the 
previous day.

Parameter Description

-dataset <ACT|MSG|CFG|SRV_LOG|create_view|drop_view>
ACT: export OVO/HPOM Active Message Statistics.
HIST: export OVO/HPOM Consolidated Messages.
CFG: export OVO/HPOM channel configuration.
SRV_LOG: export OVO/HPOM Service Log records.
create_view: create OVO/HPOM Active Message Statistics database 
views.
drop_view: remove OVO/HPOM Active Message Statistics database 
views.

-database “Name” of OVO/HPOM server to connect to and export OVO/HPOM 
data from. The specified name must match an entry in PI’s 
systems.xml file based on the “<Name>” tag field in the 
systems.xml file. This must also match an entry in the .prp file.
Normally, no OVO/HPOM server is specified and data is collected 
from all OVO/HPOM servers listed in the .prp file.

-datadir By default, data is exported to $DPIPE_HOME/data/ImportData/
OVO_Reporting. A different location can be specified using this 
option.

-prevdays Specifies the number of days prior to today to collect data inclusive 
of today. Only used if the previous collection time is not stored in the 
maxtime <TIME_TABLE>_<TIME_FIELD> file or for the first 
execution. The default value is 2 days. This parameter only applies 
to History and Service log data.

-debug Set for Debug output.

-help Display help information.

-version Display ovo_datapipe version.

-V Display ovo_datapipe version.

-server Either u7, u8, u9, w7, w8 or w9, corresponding to the database 
specified by -database
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The -prevdays option does not apply to all datasets. For example, the OVO/HPOM Active 
Message table export process does not actually export message records. Instead, a small 
number of records are captured that provide a snapshot of “current” record statistics for the 
OVO/HPOM Active Message table. In this case there is no need to specify a maximum number 
of days to include in the export process.

Testing the Export Process

Example:

Run the following command to test the export process:

ovo_datapipe –database <XYZ> –server <u9> –dataset ACT

To view the results, navigate to the following directory:

data/ImportData/OVO_Reporting

OVO/HPOM export files are imported into PI and then deleted by default. If archiving is 
enabled, you can avoid filling up the filesystem by setting up a process to clean out the export 
files. Clean the export files from the following location on the PI server:

{DPIPE_HOME}/data/ImportData/OVO_Reporting/Archive
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3 Verification Steps
This chapter explains how to confirm that OVO Reporting is properly installed and working 
correctly. It answers the following questions: 

• Does trendtimer.sched contain collection and roll up entries?

• Did the reports deploy as expected during package installation?

• Is the data export program working?

• Is PI importing data?

• Are the hourly tables being populated?

• Are the daily tables being populated?

• How can I remove the OVO report pack?

Following the verification steps in this chapter is not mandatory. Skip them unless you have 
reason to believe that something is not working properly.

Collection and Rollup Entries in trendtimer.sched

The installation process adds entries to trendtimer.sched to ensure that processes are 
executed as needed by trendtimer. The following entries are added to trendtimer.sched:

# HP OVO Reporting Project

1:00+5 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
OVO_Datapipe_Hourly.pro

24:00+2:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
OVO_Datapipe_Daily.pro

### OVO Reporting Daily Processing

24:00+8:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
Daily_OVO_Rollup.pro

Correct Deployment of Reports

If the deploy reports options was selected during the installation process, the reports were 
deployed to the PI server you specified. To verify that the reports deployed as expected, check 
this directory:

{DPIPE_HOME}/reports/deploy/system/OVO_Reporting
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Data Export Program is Working

Data collection takes place for the first time at 5 minutes past the hour (1:00+5 - -), in 
accordance with entries added to trendtimer.sched for data collection when OVO Reporting 
was installed. This process exports records from the OVO/HPOM database into flat files on 
the PI server. The OVO/HPOM data is later imported into the PI database and summarized 
by the daily rollup process specific to each dataset.

You can run the following command to initiate the ovo_datapipe export process manually:

trend_proc -f {DPIPE_HOME}/scripts/OVO_Datapipe_Hourly.pro

The exported data should be located in the following directory:

{DPIPE_HOME}/data/ImportData/OVO_Reporting

The exported OVO/HPOM data in that directory should be in files with names similar to the 
following:

OVO_ACT_ONA_<OVO/HPOM server name>_<date>_<time>.dat

OVO_ACT_ONM_<OVO/HPOM server name>_<date>_<time>.dat

OVO_ACT_ONS_<OVO/HPOM server name>_<date>_<time>.dat

OVO_MSG_HIST_<OVO/HPOM server name>_<date>_<time>.dat

OVO_MSG_ACT_<OVO/HPOM server name>_<date>_<time>.dat

OVO_SRV_LOG_<OVO/HPOM server name>_<date>_<time>.dat

OVO_CFG_LOG_<OVO/HPOM server name>_<date>_<time>.dat

The first time the ovo_datapipe program runs, by default, the program exports data records 
received since midnight of the previous day. You can override the default. To force the export 
process to include records from further back in time, use the -prevday option and specify the 
number of days. This parameter only affects the first time the export program is executed for 
a specific dataset. After that, the export program keeps track of the last exported timestamps 
and only exports the records that arrived since the previous export.

To override the default, add the -prevday option to the ovo_datapipe statements before 
running the datapipe the first time. If there are any timestamp files in {DPIPE_HOME}/
Data/ImportData/OVO_Reporting, these timestamp files will override the -prevday 
option. They must be deleted for the -prevday option to work.
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PI is Importing Data

The OVO/HPOM data is imported into the PI database hourly for Active message, History 
message, and Service log, and daily for Configuration. Each rollup process imports the 
appropriate dataset files and then steps through the roll up of that dataset. 

The import process populates the following data tables in the PI database with records.

• R_OVO_MSG_BASE

• R_OVO_ACT_BASE

• R_OVO_SRVLOG_BASE

• R_OVO_CONFIG_BASE

Use Table Manager to verify by navigating to the OVO_Reporting Category and locating the 
tables listed above.

The oldest and most recent time stamps can be determined for the import tables by running 
the following SQL statement in SQLplus, ISQL, or SQL Advantage:

select ‘R_OVO_MSG_BASE’, min(ta_period), max(ta_period) from 
R_OVO_MSG_BASE

select ‘R_OVO_ACT_BASE’, min(ta_period), max(ta_period) from 
R_OVO_ACT_BASE

select ‘R_OVO_SRVLOG_BASE’, min(ta_period), max(ta_period) from 
R_OVO_SRVLOG_BASE

select ‘R_OVO_CONFIG_BASE’, min(ta_period), max(ta_period) from 
R_OVO_CONFIG_BASE

This should return valid date/times in the second and third column if data was imported.

The OVO/HPOM export files are archived to the following location by the PI data import 
process:

{DPIPE_HOME}/data/ImportData/OVO_Reporting/Archive

If the OVO/HPOM export files are in the “OVO_Reporting” directory but not in the “Archive” 
directory, the OVO/HPOM export ran successfully but the import process was not successful. 
You can find errors relating to the import process in this file:

{DPIPE_HOME}/log/trend.log

The data is imported into PI once per day as part of the daily rollup process.

Records are only added to these tables if the OVO/HPOM server has received new records for 
those datasets.
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Hourly Data Tables are Populated

After several hours of data have been imported into OVO Report Pack base tables in the PI 
database, the hourly rollup process can be initiated as follows:

1 Change directory to {DPIPE_HOME}/scripts

2 Run the following commands:

a trend_proc -f Daily_OVO_ACT_Rollup.pro

b trend_proc -f Daily_OVO_MSG_Rollup.pro

c trend_proc -f Daily_OVO_SRVLOG_Rollup.pro

d trend_proc -f Daily_OVO_CFG_Rollup.pro

3 Use Table Manager to verify that the hourly data tables have been populated, or run the 
following SQL statements:

select ‘SH_OVO_MSG’, min(ta_period), max(ta_period) from SH_OVO_MSG

select ‘SH_OVO_ACT’, min(ta_period), max(ta_period) from SH_OVO_ACT

If data was rolled up to the hourly level, these statements should return valid date/times 
in the second and third column.

The individual steps of any trend_proc file can be executed at the command line as 
long as the environment variables are defined correctly and slashes are in the 
correct direction (/).
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Daily Tables Are Populated

After a complete day of data was imported into the OVO Report Pack’s Base tables within the 
PI database, the daily rollup process can be initiated again using the same command as 
specified above:

1 Change directory to {DPIPE_HOME}/scripts

2 Run the following commands:

a trend_proc -f Daily_OVO_ACT_Rollup.pro

b trend_proc -f Daily_OVO_MSG_Rollup.pro

c trend_proc -f Daily_OVO_SRVLOG_Rollup.pro

d trend_proc -f Daily_OVO_CFG_Rollup.pro

3 Use Table Manager to verify that the daily data tables were populated, or run the 
following SQL statements:

a select ‘SD_OVO_MSG’, min(ta_period), max(ta_period) from 
SD_OVO_MSG

b select ‘SD_OVO_ACT’, min(ta_period), max(ta_period) from 
SD_OVO_ACT

c select ‘SD_OVO_SRVLOG’, min(ta_period), max(ta_period) from 
SD_OVO_SRVLOG

If data rolled up to the daily level, these statements should return valid date/times in the 
second and third column.

The daily rollup processes also force the summarization to the weekly, monthly, and baseline 
level, if enough time has passed and enough data was collected to summarize to those levels. 
Data can only roll up to the next time interval when the time period is complete. For example, 
monthly data for current month is not generated until the current month ends.

Verify those tables using the following SQL statements:

select ‘SW_OVO_MSG’, min(ta_period), max(ta_period) from SW_OVO_MSG

select ‘SM_OVO_MSG’, min(ta_period), max(ta_period) from SM_OVO_MSG

select ‘SW_OVO_ACT’, min(ta_period), max(ta_period) from SW_OVO_ACT

select ‘SM_OVO_ACT’, min(ta_period), max(ta_period) from SM_OVO_ACT

select ‘SW_OVO_SRVLOG’, min(ta_period), max(ta_period) from 
SW_OVO_SRVLOG

select ‘SM_OVO_SRVLOG’, min(ta_period), max(ta_period) from 
SM_OVO_SRVLOG
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Uninstalling the OVO Report Pack

Perform the following steps to uninstall the OVO Report Pack.

1 Log on to the system. On UNIX systems, log on as root.

2 Stop the PI Timer and wait for processes to terminate.

Windows: Select Settings → Control Panel → Administrative Tools → Services.

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer stop

Solaris and Linux: sh /etc/init.d/ovpi_timer stop

3 Start Package Manager. The Package Manager welcome window opens.

4 Click Next. The Package Location window opens.

5 Click Uninstall.

6 Click Next. The Report Undeployment window opens.

7 If reports were deployed from this server, accept the defaults for Undeploy Reports, 
Application Server Name, and Port. If reports were not deployed from this server, clear 
the check box and skip to step 9.

8 Type the username and password for the PI Application Server.

9 Click Next. The Package Selection window opens. 

10 Click the check boxes next to the following packages, if they appear in the list:

— OVO Reporting 1.41

— OVO Datapipe 1.41

11 Click Next. The Selection Summary window opens. 

12 Click Uninstall. The Progress window opens and the removal process begins. When the 
uninstall process is complete, a package removal complete message appears. 

13 Click Done to return to the Management Console.

14 Restart the PI Timer.

Windows: Select Settings → Control Panel → Administrative Tools → Services.

UNIX: As root, do one of the following:

HP-UX: sh /sbin/init.d/ovpi_timer start

Solaris and Linux: sh /etc/init.d/ovpi_timer start
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4 Setting Up a Distributed System
Overview of the Steps

1 Decide whether you want local reporting on the satellite servers or central reporting only.

2 Install the right set of packages on each server (a central server that is not polling does 
not need datapipes. The satellite servers need datapipes).

3 Verify that the system clocks in your environment are synchronized.

4 Register your satellite servers.

5 If you are not copying rate data to the central server, enable LIR on the central server.

6 If you enable LIR, add LIR mapping with the time type set to rate.

7 Verify that you have all the copy policies you need.

8 Configure the central server (manual edits to trendtimer.sched and .pro files).

9 Configure each satellite server (manual edits to trendtimer.sched and .pro files).

If you want local reporting, you must deploy reports when you install the report pack on each 
satellite server, and you must also allow summarizations to run on each satellite server. If you 
do not want local reporting, you do not need to deploy reports when you install a report pack 
on a satellite server, and you can disable the scripts that run summarizations on each satellite 
server.

Before Location Independent Reporting (LIR) was available, the recommendation for setting 
up a distributed system was to deploy reports on satellite servers, keep rate data on satellite 
servers, copy hourly data to the central server, and disable summarizations above the hourly 
level on satellite servers. This approach had two benefits. It kept a lot of rate data off the 
network, and it decreased the processing load on the central server. The problem with this 
approach is that the central server could not display a Near Real Time (NRT) report. The only 
NRT report was a local NRT report, on a satellite server. 

LIR fixes this problem. If you enable LIR, you can open an NRT report on the central server 
and drill-down on table selections. Your selections cause the central server to query a satellite 
server for locally aggregated data. If you would rather copy rate data to the central server, you 
can, and then enabling LIR is not necessary.

OVO Report Pack now comes with a copy policy import file. When you install OVO Report 
Pack, PI uses this file to generate copy policies. Creating these policies yourself, using the 
Management Console, is no longer necessary. Your only task is to verify that you have copy 
policies for the following tables:

• SD_OVO_SRVLOG

• SH_OVO_MSG

• R_OVO_CONFIG_BASE

• SH_OVO_ACT
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Because you are likely to have multiple satellite servers, the hourly process files were 
designed to be satellite-server friendly. This means that most of the time, most of the defaults 
are correct. But some defaults will be incorrect, or less than optimal, and to improve 
performance, you should change them. These manual edits, as well as the other steps listed 
above, are spelled out in detail in this chapter.

Verifying Correct Package Installation

Verify that you have the right packages installed on each server. 

Packages on the Central Server

• OVO Report Pack, with reports deployed

• Common Property Tables, with forms deployed

Packages on Each Satellite Server

• OVO Report Pack 

• Common Property Tables 

• OVO Datapipe

Typically, the central server does not poll. If you want the central server in your system to 
poll, install a datapipe on the central server. If you want to view reports on satellite servers 
(local reporting) accept the Deploy Reports option when you install report packs at each 
satellite server. If central server reporting is the only reporting you want, you do not need to 
deploy reports and forms when you install report packs at satellite servers. 
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Configuring the Central Server

To configure the central server, perform the following tasks:

Task 1: Register the satellite server by setting the database role

Perform the following steps to register a satellite server:

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the PI Databases folder and select the server you want as the satellite server. 
Typically the servers are under “standalone servers”.

4 Click Database Properties.

5 From the Database Role list, select the Satellite Server role.

6 Enter any information necessary to configure the Satellite Server role.

Task 2: Enable LIR

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the PI Databases folder and select the central server.

4 Click LIR Configuration.

5 Select the LIR enabled check box.

Task 3: Add LIR mappings

1 Start the Management Console (log on with Administrator privileges).

2 Click the Systems icon in the navigation pane.

3 Navigate to the PI Databases folder and select the central server.

4 Click LIR Configuration.

5 Click Add Mapping.

6 From the Select Satellite Server list, select a satellite server to which to add a mapping.

7 Select the Category data table option.

8 Select OVO from the drop down list.

9 Select the rate data type.

10 Click Add to List.

11 Click OK.

12 Click Apply.

To add a new database reference, use the Add Database Reference Wizard in the System and 
Network Administration application.
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A copy policy is automatically generated for the hourly data and for each LIR mapping that 
you add. The data type you select determines the type of data copied. The type of data copied 
(defined in the generated copy policy) is one summarization level greater than the data type 
selected in the LIR mapping. For example, if you select an hourly data type, you can generate 
a daily data copy policy.

Task 4: Verify the automatically generated copy policies

Verify that a copy policy was generated for the following tables and that the copy type is set 
correctly (to Property and Data):

1 Start the Management Console (log on with Administrator privileges).

2 Click the Copy Policy icon in the navigation pane to start the Copy Policy Manager.

3 The following tables should appear in the copy policy list:

• SD_OVO_SRVLOG

• SH_OVO_MSG

• R_OVO_CONFIG_BASE

• SH_OVO_ACT

For each table, verify that copy type is set to Property and Data.

4 If a copy policy was not generated for any of the tables listed above, click the New Copy 
Policy icon or select File → New Copy Policy from the Copy Policy Manager. The Copy Policy 
Wizard opens.

5 Click Next. The Satellite Server and Copy Policy Selection Page opens.

6 Select a satellite server from the pull down list. This is the satellite server from which 
data is copied to the central server.

7 Select Single Table and select the table from the pull down list.

8 Click Next. The Copy Type Selection Page opens.

9 Select Property and Data.

10 Click Next. The Summary page opens.

11 Verify the information in the summary window. If the information is not correct, modify it 
by clicking Back.

12 Click Finish.

13 Repeat step 4 - step 12 for all missing tables.

If only the copy type is not set to Property and Data, do the following:

1 Double-click the copy policy.

2 Select the Property and Data copy type.

3 Click OK.

Task 5: Edit trendtimer.sched and multiple process files.

1 Change the trendtimer.sched file located in {DPIPE_HOME}/lib for the central server 
from this:

## 24:00+8:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
Daily_OVO_Rollup.pro

to this:
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## 24:00+9:00 - - {DPIPE_HOME}/bin/trend_proc -f {DPIPE_HOME}/scripts/
Daily_OVO_Rollup.pro 

2 Edit the Daily_OVO_MSG_Rollup.pro file:

• Comment out block 1, 

3 Edit the Daily_OVO_ACT_Rollup.pro file:

• Comment block 1,

4 Edit the Daily_OVO_SRVLOG_Rollup.pro file:

• Comment out block 1,

5 Edit the Daily_OVO_CONFIG_Rollup.pro file:

• Comment out block2,

For more information about LIR and copy policies, see the HP Performance Insight 
Administration Guide.

Configuring Satellite Servers

Configure each satellite server by enabling copy commands that are disabled by default. Once 
the copy commands are enabled, the central server handles the summarizations. The copy 
commands appear in hourly process files in the Scripts directory. 

Make the following changes to four process files:

1 Open the Daily_OVO_MSG_Rollup.pro file:

a Uncomment block 2

b Comment out block 3 

c Change block 2 to 

begin: block2 wait
{DPIPE_HOME}/bin/trendcopy -t SH_OVO_MSG
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_LOOKUP_D
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_LOOKUP_S
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_LOOKUP_A
{DPIPE_HOME}/bin/trendcopy -t R_OVO_MSG_BASE
{DPIPE_HOME}/bin/trendcopy -t SD_OVO_MSG
end: block2 

2 Open the Daily_OVO_ACT_Rollup.pro file:

a Uncomment block 2

b Comment out block 3

c Change block 2 to: 

begin: block2 wait
{DPIPE_HOME}/bin/trendcopy -t SH_OVO_ACT
{DPIPE_HOME}/bin/trendcopy -t R_OVO_ACT_BASE
end: block2 

Configuring satellite servers is not required. However, commenting out unnecessary 
aggregation on satellite servers and central server enables the system to run faster.
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3 Open the Daily_OVO_SRVLOG_Rollup.pro file:

a Uncomment block 2

b Comment out block 3

4 Open the Daily_OVO_CONFIG_Rollup.pro file:

• Uncomment block 2

System Clocks

Make sure the system clock on each satellite server is synchronized with the system clock on 
the central server. 
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5 Active Message Reports
The following reports contain information about current unacknowledged messages.

OVO/HPOM Server Summary (see sample page 41)

Total number of messages and severity details for each management server. For a selected 
management server, provides statistics for severity, age, and duplicates daily, weekly and 
monthly.

Message Severity Trend by All Messages (see sample page 43)

Summary of all messages across all management servers by severity. Includes statistics for 
message age, severity, volume, duplicates, and special flag counts hourly, daily, weekly and 
monthly.

Message Severity Trend by Application

A list of 15 applications with the most associated messages. Includes the following details for 
the selected application: Message age, severity, volume, duplicates, and special flag counts 
hourly, daily, weekly and monthly.

Message Severity Trend by Message Group

A list of 15 message groups with the most associated messages. Includes the following details 
for a selected message group: Message age, severity, volume, duplicates, and special flag 
counts hourly, daily, weekly and monthly.

Message Severity Trend by Node and Service

A list of 15 nodes, and corresponding services running on those nodes, with the most 
associated messages. Includes the following details for a selected node and service pair: 
Message age, severity, volume, duplicates, and special flag counts hourly, daily, weekly and 
monthly.

Message Severity Trend by Server

A list of 15 management servers that have the most associated messages, with the following 
details for a selected Operations management server: message age, severity, volume, 
duplicates, and special flag counts hourly, daily, weekly and monthly.

Message Severity by Server and Application

A list of 15 management servers, and corresponding applications being managed by those 
servers, that have the most associated messages. Include the following details for a selected 
management server and application pair: Message age, severity, volume, duplicates, and 
special flag counts hourly, daily, weekly and monthly.
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Message Severity by Server and Message

A list of 15 management servers, and corresponding message groups being monitored by those 
servers, that have the most associated messages. Includes the following details for a selected 
management server and message group pair: Message age, severity, volume, duplicates, and 
special flag counts hourly, daily, weekly and monthly.

Message Severity by Server and Node

A list of the 15 management servers, and corresponding nodes being managed by those 
servers, that have the most associated messages. Includes the following details for a selected 
management server and node pair: Message age, severity, volume, duplicates, and special flag 
counts hourly, daily, weekly and monthly.

Message Severity by Server and Service

A list of 15 management servers, and corresponding services being managed by those servers, 
that have the most associated messages. Includes the following details for a selected 
management server and service pair: Message age, severity, volume, duplicates, and special 
flag counts hourly, daily, weekly and monthly.

Message Severity by Server, Node and Application 

A list of 15 management servers, and corresponding nodes and applications on those nodes, 
that have the most associated messages. Includes the following details for a selected 
management server, node and application: Message age, severity, volume, duplicates, and 
special flag counts hourly, daily, weekly and monthly.

Message Severity by Server, Node, and Message Group

A list of 15 management servers, and corresponding nodes and message groups from those 
nodes, that have the most associated message. Includes the following details for a selected 
management server, node and message count threesome: Message age, severity, volume, 
duplicates, and special flag counts hourly, daily, weekly and monthly.

Message Severity by Server, Node, and Service

A list of 15 management servers, and corresponding nodes and services on those nodes, that 
have the most associated messages. Includes the following details for a selected management 
server, node and service threesome: Message age, severity, volume, duplicates, and special flag 
counts hourly, daily, weekly and monthly.

Message Severity by Service

A list of 15 services that have the most associated messages. For a selected service, includes 
statistics for message age, severity, volume, duplicates, and special flag counts hourly, daily, 
weekly and monthly.
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6 History Message Reports
This chapter contains brief descriptions of the reports about history messages. A history 
message can be unacknowledged or acknowledged.

History Dashboard by Server and Node

A list of the top 30 management server and nodes with the most severe messages and the 
most special flags.

History Dashboard by Server Node and Template 

A list of the top 30 management servers, nodes and templates with the most severe messages 
and the most special flags.

Message Age Severity Trend by Server and User

Management servers and users that have the daily messages with the longest age (where age 
refers to the amount of time that it took a user to acknowledge/clear the alarm) and details 
hourly, daily, weekly and monthly message age, severity, volume, duplicates, special flags, 
and delay in seconds for the selected management server and user pair.

Message OVO/OM Server Summary

Displays message severity for each Operations management server and for the selected 
server, details message severity, age and duplicates daily, weekly and monthly.

Message Severity Trend by All Message 

Provides a summary of all messages across all management servers by severity and details 
message age, severity, volume, duplicates, special flag counts and delay in seconds hourly, 
daily, weekly and monthly.

Message Severity Trend by Application 

A list of 15 applications that have the most associated messages and details for a selected 
application the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.

Message Severity Trend by Message Group

A list of 15 message groups that have the most associated messages and details for a selected 
message group the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.

Message Severity by Node 

A list of 15 nodes that have the most associated messages and details for a selected node the 
message age, severity, volume, duplicates, special flag counts, and delay in seconds hourly, 
daily, weekly and monthly. 
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Message Severity by Node and Application 

A list of 15 nodes and corresponding applications on those nodes that have the most 
associated messages and details for a node and application pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

Message Severity by Node and Message Group 

A list of 15 nodes and corresponding message groups on those nodes that have the most 
associated messages and details for a node and message group pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

Message Severity Trend by Node and Template 

A list of 15 nodes and corresponding templates managing those nodes that have the most 
associated messages and details for a selected node and template pair the message age, 
severity, volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and 
monthly.

Message Severity Trend by Node and Service

A list of 15 nodes and corresponding services running on those nodes that have the most 
associated messages and details for a selected node and service pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

Message Severity Trend by Server 

A list of 15 Operations management servers that have the most associated messages and 
details for a selected Operations management server the message age, severity, volume, 
duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

Message Severity Trend by Server and Message Group 

A list of 15 Operations management servers and corresponding message groups being 
monitored by those servers that have the most associated messages and details for a selected 
management server and message group pair the message age, severity, volume, duplicates, 
special flag counts and delay in seconds hourly, daily, weekly and monthly.

 Message Severity by Server and Node 

A list of 15 Operations management servers and corresponding nodes being managed by those 
servers that have the most associated messages and details for a selected management server 
and node pair the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.

Message Severity by Server and Service

A list of 15 Operations management servers and corresponding services being managed by 
those servers that have the most associated messages and details for a selected management 
server and service pair the message age, severity, volume, duplicates, special flag counts and 
delay in seconds hourly, daily, weekly and monthly.

Message Severity by Server 

A list of 15 Operations management servers and corresponding templates monitored by those 
servers that have the most associated messages and details for a selected management server 
and template pair the message age, severity, volume, duplicates, special flag counts and delay 
in seconds hourly, daily, weekly and monthly.
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Message Severity by Server and Application 

A list of 15 Operations management servers and corresponding applications being managed 
by those servers that have the most associated messages and details for a selected 
management server and application pair the message age, severity, volume, duplicates, 
special flag counts and delay in seconds hourly, daily, weekly and monthly.

Message Severity by Server, Node and Application 

A list of 15 Operations management servers and corresponding nodes and applications on 
those nodes that have the most associated messages and details for a selected management 
server, node and application threesome the message age, severity, volume, duplicates, special 
flag counts and delay in seconds hourly, daily, weekly and monthly.

Message Severity by Server, Node and Message Group 

A list of 15 Operations management servers and corresponding nodes and message groups 
from those nodes that have the most associated messages and details for a selected 
management server, node and message count threesome the message age, severity, volume, 
duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

Message Severity by Server, Node and Service 

A list of 15 Operations management servers and corresponding nodes and services on those 
nodes that have the most associated messages and details for a selected management server, 
node and service threesome the message age, severity, volume, duplicates, special flag counts 
and delay in seconds hourly, daily, weekly and monthly.

Message Severity by Server, Template and Condition 

A list of 15 Operations management servers and corresponding monitored templates and 
occurred conditions on those servers that have the most associated messages and details for a 
selected management server, template and condition threesome the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

Message Severity Trend by Server and User

A list of 15 Operations management servers and corresponding users on those servers that 
have the most associated messages and details for a selected management server and user 
pair the message age, severity, volume, duplicates, special flag counts and delay in seconds 
hourly, daily, weekly and monthly.

Message Severity Trend by Service 

A list of 15 services that have the most associated messages and details for a selected service 
the message age, severity, volume, duplicates, special flag counts and delay in seconds hourly, 
daily, weekly and monthly.

Message Severity by Template

A list of 15 templates that have the most associated messages and details for a selected 
template the message age, severity, volume, duplicates, special flag counts and delay in 
seconds hourly, daily, weekly and monthly.
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Message Severity by Template and Condition

A list of 15 templates and corresponding occurred conditions that have the most associated 
messages and details for a selected template and condition pair the message age, severity, 
volume, duplicates, special flag counts and delay in seconds hourly, daily, weekly and monthly.

Message Severity by User 

A list of 15 users that have the most associated messages and details for a selected user the 
message age, severity, volume, duplicates, special flag counts and delay in seconds hourly, 
daily, weekly and monthly.

Monthly Server Breakdown with Special Flag 

A list of the top 20 Operations management servers with the most messages with notify and 
trouble ticket details and a graph of hourly, daily, weekly and monthly special flag counts.

Template Breakdown with Special Flags 

A list of the top 20 templates with the most messages with notify and trouble ticket details 
and a graph of hourly, daily, weekly, and monthly special flag counts.
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7 Configuration Reports
The OVO Report Pack includes two configuration reports:

Notification Channels

Lists the program, service, day, starting time and ending time for each Operations 
management server notification channel for the current and previous day.

Trouble Ticket Channels (see sample page 46)

Shows the program, on/off flag and time period for each Operations management server for 
the current and previous day.
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8 Reports for HPOM 9.0 (OVO9)
Weekly History Dashboard by Server and Template
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Weekly History Dashboard by Template
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Message Reports

History Dashboard by Server Node and Template
Reports for HPOM 9.0 (OVO9) 97



Message Severity by Message Template
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Message Severity by Template Trend 
Reports for HPOM 9.0 (OVO9) 101
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Template Breakdown with Special Flags
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A Import and Reporting Tables
This appendix contains the following tables:

• Import tables:

— History message table

— Active message statistics table

— Service log entries table

— Configuration entries table

• Reporting tables:

— History message property table

— History message data tables

— Consolidated message metrics by time interval

— Active message property table

— Active message data tables

— Active message metrics by time interval

— Service log property table

— Service log data tables

— Service log metrics by time interval
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History Message Import Table

R_OVO_MSG_BASE

K_OVO_MSG_BASE

The following fields apply to OVO for UNIX/HPOM for UNIX only. They do not apply to OVO 
for Windows /HPOM for Windows:
• APPLICATION_ID
• ESCALATE_FLAG
• IP_ADDRESS
• NOTIFY_SERVICES
• status_flag
• TEMPLATE_DESCRIPTION

Each field listed above is bold in the table below.

PI Field  Type

OVO for UNIX/
HPOM for 
UNIX Table(s) 
HISTORY

OVO for UNIX/
HPOM for 
UNIX Table(s) 
ACTIVE

OVO for UNIX/
HPOM for UNIX 
Field

OPC_MSG_
MESSAGES

OPC_ACT_MES
SAGES

CMA_FLAG

ACKN_AFTER_T
T_FLAG

OPC_MSG_
MESSAGES

OPC_ACT_MES
SAGES

ACKN_AFTER_TT_
FLAG

ACKN_TIME OPC_MSG_
MESSAGES

OPC_ACT_MES
SAGES

ACKN_TIME

ACKN_USER Vchar(20) OPC_MSG_
MESSAGES

OPC_ACT_MES
SAGES

ACKN_USER

APPLICATION Vchar(254) OPC_MSG_
MESSAGES

OPC_ACT_MES
SAGES

APPLICATION

APPLICATION_
ID

Vchar(254) Opc_msg_
Messages

Opc_act_
messages

APPLICATION_ID

AUTO_ACKN_
FLAG

OPC_MSG_ME
SSAGES

OPC_ACT_
MESSAGES

AUTO_ACKN_
FLAG

AUTO_ANNO_
FLAG

OPC_MSG_ME
SSAGES

OPC_ACT_
MESSAGES

AUTO_ANNO_
FLAG

AUTO_CALL OPC_MSG_ME
SSAGES

OPC_ACT_
MESSAGES

AUTO_CALL

AUTO_NODE_
ID

OPC_MSG_ME
SSAGES

OPC_ACT_
MESSAGES

AUTO_NODE_ID

AUTO_STATUS OPC_MSG_ME
SSAGES

OPC_ACT_
MESSAGES

AUTO_STATUS
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cma_name opc_MSG_cust_
attrib

opc_act_cust_
attrib

cma_name

cma_value opc_MSG_cust_
attrib

opc_act_cust_
attrib

cma_value

CONDITION_
ID

Vchar(36) OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

CONDITION_ID

DESCRIPTION Vchar(254) OPC_COND, 
OPC_TRAP_
COND, 
OPC_MONITO
R_COND

OPC_COND, 
OPC_TRAP_
COND, 
OPC_MONITOR
_COND

DESCRIPTION

DUPL_COUNT OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

DUPL_COUNT

ESCALATE_
FLAG

OPC_MSG_ME
SSAGES

OPC_ACT_MES
SAGES

ESCALATE_FLAG

FORWARD OPC_MSG_ME
SSAGES

OPC_ACT_MES
SAGES

FORWARD

IP_ADDRESS OPC_NODE_
NAMES

OPC_NODE_
NAMES

IP_ADDRESS

LAST_TIME_
RECEIVED

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

LAST_TIME_
RECEIVED

LOCAL_ACKN_
TIME

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

LOCAL_ACKN_
TIME

LOCAL_AGT_
CREATION_
TIME

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

LOCAL_AGT_
CREATION_TIME

LOCAL_CREATI
ON_TIME

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

LOCAL_CREATION
_
TIME

LOCAL_LAST_T
IME_RECEIVED

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

LOCAL_LAST_
TIME_RECEIVED

LOCAL_RECEIV
ING_TIME

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

LOCAL_RECEIVIN
G_TIME

LOCAL_RECEIV
ING_TIME

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

LOCAL_RECEIVIN
G_TIME

LOCAL_UNBUF
FER_TIME

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

LOCAL_UNBUFFER
_TIME

LOG_ONLY_
FLAG

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

LOG_ONLY_FLAG

PI Field  Type

OVO for UNIX/
HPOM for 
UNIX Table(s) 
HISTORY

OVO for UNIX/
HPOM for 
UNIX Table(s) 
ACTIVE

OVO for UNIX/
HPOM for UNIX 
Field
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MESSAGE_
GROUP

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

MESSAGE_GROUP

MESSAGE_
NUMBER

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

MESSAGE_NUMBE
R

MESSAGE_
TYPE

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

MESSAGE_TYPE

MSG_GEN_
NODE_ID

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

MSG_GEN_NODE_I
D

MSG_KEY OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

MSG_KEY

MSG_SOURCE_
NAME

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

MSG_SOURCE_
NAME

MSG_SOURCE_
TYPE

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

MSG_SOURCE_TYP
E

NODE_ID OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

NODE_ID

NODE_NAME Vchar(64) OPC_NODE_
NAMES

OPC_NODE_NA
MES

NODE_NAME

NOTIFICATION
_FLAG

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

NOTIFICATION_FL
AG

NOTIFY_
SERVICES

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

NOTIFY_SERVICES

OBJECT OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

OBJECT

OP_INIT_ACKN
_FLAG

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

OP_INIT_ACKN_FL
AG

OP_INIT_
ANNO_FLAG

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

OP_INIT_ANNO_FL
AG

OP_INIT_CALL OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

OP_INIT_CALL

OP_INIT_
NODE_ID

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

OP_INIT_NODE_ID

OP_INIT_
STATUS

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

OP_INIT_STATUS

OVO_SERVER Vchar(16)

RECEIVING_
TIME

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

RECEIVING_TIME

PI Field  Type

OVO for UNIX/
HPOM for 
UNIX Table(s) 
HISTORY

OVO for UNIX/
HPOM for 
UNIX Table(s) 
ACTIVE

OVO for UNIX/
HPOM for UNIX 
Field
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service_id opc_notif_
schedule

opc_notif_
schedule

service_id

SERVICE_
NAME

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

SERVICE_NAME

SEVERITY OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

SEVERITY

status_flag opc_trouble_
ticket

opc_trouble_
ticket

status_flag

TEMPLATE_
DESCRIPTION

Vchar(254) opc_templ_
options

opc_templ_
options

TEMPLATE_
DESCRIPTION

TEMPLATE_ID Vchar(36) opc_templ_
options

opc_templ_
options

TEMPLATE_ID

TEMPLATE_
NAME

opc_templ_
options

opc_templ_
options

TEMPLATE_NAME

TROUBLE_
TICK_FLAG

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

TROUBLE_TICK_FL
AG

UNBUFFER_
TIME

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

UNBUFFER_TIME

UNMATCHED_
FLAG

OPC_MSG_
MESSAGES

OPC_ACT_
MESSAGES

UNMATCHED_FLA
G

PI Field  Type

OVO for UNIX/
HPOM for 
UNIX Table(s) 
HISTORY

OVO for UNIX/
HPOM for 
UNIX Table(s) 
ACTIVE

OVO for UNIX/
HPOM for UNIX 
Field
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Active Message Import Table

R_OVO_ACT_BASE

K_OVO_ACT_BASE

Column Name Data Type Description  Source Table
Commen
t

OVO_SERVER varchar(128) The server 
records were 
exported from

Created 
by export 
process

NODE_NAME (based 
on NODE_ID)

varchar(254)
varchar2(1024)

OPC_NODE_
NAMES

All 
records

NODE_ID (ID of node 
where event occurred)

varchar2(36) OPC_ACT_
MESSAGES

All 
records

APPLICATION varchar2(254) ONA records 
only

OPC_ACT_
MESSAGES

ONA 
records 
only

SERVICE_
NAME

varchar2(2048) ONS records 
only

OPC_ACT_
MESSAGES

ONS 
records 
only

MSG_GROUP varchar2(32) ONM records 
only

OPC_ACT_
MESSAGES

ONM 
records 
only

OVO_GMT_
OFFSET

number(12) All 
records

CNT_
MESSAGES

gauge/float Count of current 
ACTIVE 
messages

OPC_ACT_
MESSAGES

All 
records

CNT_UNKNOWN gauge/float With severity = 
1 = unknown

OPC_ACT_
MESSAGES

All 
records

CNT_NORMAL gauge/float With severity = 
2 = normal

OPC_ACT_
MESSAGES

All 
records

CNT_WARNING gauge/float With severity = 
4 = warning

OPC_ACT_
MESSAGES

All 
records

CNT_CRITICAL gauge/float With severity = 
8 = critical

OPC_ACT_
MESSAGES

All 
records

CNT_MINOR gauge/float With severity = 
16 = minor

OPC_ACT_
MESSAGES

All 
records

CNT_MAJOR gauge/float With severity = 
32 = major

OPC_ACT_
MESSAGES

All 
records

MIN_AGE_MSG gauge/float Minimum age of 
current ACTIVE 
messages

OPC_ACT_
MESSAGES

All 
records
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MAX_AGE_MSG gauge/float Maximum age of 
current ACTIVE 
messages

OPC_ACT_
MESSAGES

All 
records

AVG_AGE_MSG gauge/float Average age of 
current ACTIVE 
messages

OPC_ACT_
MESSAGES

All 
records

TOT_AGE_MSG gauge/float Total age of 
current ACTIVE 
messages

OPC_ACT_
MESSAGES

All 
records

CNT_AGE_5_MIN gauge/float Messages less 
than 5 minutes 
old

OPC_ACT_
MESSAGES

All 
records

CNT_AGE_5_10_MIN gauge/float >= 5 minutes 
and < 10 
minutes

OPC_ACT_
MESSAGES

All 
records

CNT_AGE_10_30_MIN gauge/float >= 10 minutes 
and < 30 
minutes

OPC_ACT_
MESSAGES

All 
records

CNT_AGE_30_60_MIN gauge/float >= 30 minutes 
and < 60 
minutes

OPC_ACT_
MESSAGES

All 
records

CNT_AGE_60_120_MI
N

gauge/float >= 60 minutes 
and < 120 
minutes

OPC_ACT_
MESSAGES

All 
records

CNT_AGE_120_
720_MIN

gauge/float >= 120 minutes 
and < 720 
minutes

OPC_ACT_
MESSAGES

All 
records

CNT_AGE_720_
1440_MIN

gauge/float >= 720 minutes 
and < 1440 
minutes

OPC_ACT_
MESSAGES

All 
records

CNT_AGE_GT_
1440_MIN

gauge/float > 1440 minutes OPC_ACT_
MESSAGES

All 
records

CNT_CURR_
BUFFERED

gauge/float Count current 
buffered 
messages

OPC_ACT_
MESSAGES

All 
records

CNT_PREV_
BUFFERED

gauge/float Count messages 
previously 
buffered

OPC_ACT_
MESSAGES

All 
records

CNT_DUPL_
COUNT

gauge/float Total duplicates 
received

OPC_ACT_
MESSAGES

All 
records

Column Name Data Type Description  Source Table
Commen
t
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CNT_DUPL_MSG gauge/float Count of 
messages 
receiving 
duplicates

OPC_ACT_
MESSAGES

All 
records

CNT_ESCALATE_
FLAG

gauge/float Count flagged as 
escalated

OPC_ACT_
MESSAGES

All 
records

CNT_AUTO_
ACKN_FLAG

gauge/float Count flagged as 
auto 
acknowledge

OPC_ACT_
MESSAGES

All 
records

CNT_LOG_ONLY_
FLAG

gauge/float Count flagged as 
log only

OPC_ACT_
MESSAGES

All 
records

CNT_NOTIFICATION
_FLAG

gauge/float Count flagged to 
send notification

OPC_ACT_
MESSAGES

All 
records

CNT_TROUBLE_TICK
_FLAG

gauge/float Count flagged to 
generate trouble 
ticket

OPC_ACT_
MESSAGES

All 
records

CNT_ACKN_AFTER_
TT_FLAG

gauge/float Count flagged to 
auto 
acknowledge 
after generating 
trouble ticket

OPC_ACT_
MESSAGES

All 
records

APPLICATION_ID Number Unique ID for 
long application 
names

NA ONA

NODE_IP_ADDR Number IP Address in 
long form

OPC_NODES All 
records

SERVICE_NAME_ID Number Unique ID for 
long service 
names

NA ONS

Column Name Data Type Description  Source Table
Commen
t
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Service Log Import Table

R_OVO_SRVLOG_BASE

K_OVO_SRVLOG_BASE

Column Name Data Type
Column Sample 
Data

 OVO/HPOM 
Source Table Comment

SPLIT_FLAG number Created by 
export process

ORIG_TA_PERIOD date 18/6/2007 
10:03:43 PM

Created by 
export process

OVO_SERVER varchar(128) Created by 
export process

SERVICE_NAME varchar2(20
48)

SeM_SPI:Server
@@nsprod01

OPC_SERVICE_
LOG

SEVERITY number(3) 4 OPC_SERVICE_
LOG

1. Unknown
2. Normal
4. Warning
8. Critical
16. Minor
32. Major

START_TIME number(12) 1108624087 OPC_SERVICE_
LOG

LOCAL_START_
TIME

date 4/5/2005 10:03:43 
PM

OPC_SERVICE_
LOG

TA_PERIOD

END_TIME number(12) 1108624087 OPC_SERVICE_
LOG

LOCAL_END_
TIME

date 4/5/2005 11:03:43 
PM

OPC_SERVICE_
LOG

DURATION number(12) 1108624087 Created by 
export process

OVO_GMT_
OFFSET

number(12) Created by 
export process

EXPORT_TIME number(12) 1108594373 Created by 
export process
Import and Reporting Tables 113



Configuration Import Table

R_OVO_SRVLOG_BASE [?]

K_OVO_SRVLOG_BASE [?]

The metrics in the following table are available from OVO for UNIX/HPOM for UNIX only. 
They are not available from OVO for Windows/HPOM for Windows. The following reports are 
affected:
• Notif_Channels.rep
• TT_Channels.rep

Column Name

OVO for UNIX/
HPOM for UNIX 
Source Table Comment

dsi_key_id_ Standard PI numeric element ID

ta_period Standard PI time stamp

delta_time Standard PI column not used in this case

ta_samples Standard PI column. Always 1 in this case

OVO_SERVER Created by export process

Type Record type indicator TT or NOTIF

NOTIF_SVC_ID Opc_notif_services Service Identifier

NOTIF_SVC_NAME Opc_notif_services Notif Service Name

FLAG opc_trouble_ticket Active/Inactive

PROGRAM Opc_notif_services

opc_trouble_ticket External program

DAY opc_notif_schedule Day for Notif

STARTING opc_notif_schedule Start time for Notif channel

ENDING opc_notif_schedule End time for Notif channel
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History Message Property Table

All OVO/HPOM Consolidated Message summarized data tables are associated with the 
K_OVO_MSG property tableK_OVO_MSG.

Column Name Data Type Population Method

dsi_key_id Maintained by PI

dsi_target_name Record type indicator based on trend_sum 
by the following variables:
O: OVO_SERVER
ON: OVO_SERVER - NODE_NAME
OA: OVO_SERVER - APPLICATION
OS: OVO_SERVER - SERVICE_NAME
OM: OVO_SERVER - MSG_GROUP
OU: OVO_SERVER – ACKN_USER
OT: OVO_SERVER – TEMPLATE
OTD: OVO_SERVER – TEMPLATE - 
DESCRIPTION
ONA: OVO_SERVER – NODE_NAME - 
APPLICATION
ONS: OVO_SERVER – NODE_NAME - 
SERVICE_NAME
ONM: OVO_SERVER – NODE_NAME - 
MSG_GROUP

dsi_target_name All Msgs (executive summary across all 
messages)
A: APPLICATION
S: SERVICE_NAME
M: MSG_GROUP
U: ACKN_USER
T: TEMPLATE
TD: TEMPALTE – DESCRIPTION
N: NODE
NT: NODE – TEMPLATE
NS: NODE – SERVICE
NA: NODE – APPLICATION
NM: NODE – MSG GROUP

dsi_table_key Due to custom rollup, all by variables, except 
for GRP_LEVEL and the interval by 
variable, are concatenated and inserted into 
dsi_table_key

dsi_status number(3,0) Specifies the global status attribute for the 
managed object. The default value is 2.
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dsi_status_time date Contains the timestamp of the last status. 
The default value is the current time.

dsi_descr Set to same value as dsi_table_key 

GRP_LEVEL Same as dsi_target_name

OVO_SERVER Varchar(128) trend_sum populates based on by variable 
“OVO_SERVER”

NODE_NAME Varchar(254)
Varchar2(1024)

trend_sum populates based on by variable 
“NODE_NAME”

APPLICATION Varchar2(254) trend_sum populates based on by variable 
“APPLICATION”

SERVICE_NAME Varchar2(2048) trend_sum populates based on by variable 
“SERVICE_NAME”

ACKN_USER Varchar2(20) trend_sum populates based on by variable 
“ACKN_USER”

MESSAGE_GROUP VARCHAR(255) trend_sum populates based on by variable 
“MSG_GROUP”

MSG_SOURCE_NAME VARCHAR(255) trend_sum populates based on by variable 
“TEMPLATE”

APPLICATION_ID number Unique hash for application

COND_DESCRIPTION_
ID

number Unique hash for condition description

SERVICE_NAME_ID number

CONDITION_DESCR VARCHAR(255) trend_sum populates based on by variable 
“CONDITION”

OTHER standard 
columns found in PI RPs

Column Name Data Type Population Method
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History Message Data Table

Consolidated Message Metrics by Time Period

Destination Table Rollup Processing Populating Table

SH_OVO_MSG Populated by several roll-up combinations: 
SH_OVO_MSG.nnn

SD_OVO_MSG Populated by trend_sum using SD_OVO_MSG.sum

SW_OVO_MSG Populated by trend_sum using SW_OVO_MSG.sum

SM_OVO_MSG Populated by trend_sum using SM_OVO_MSG.sum

Metric Hour Day Week Month

CNT_MESSAGES X X X X

CNT_UNKNOWN X X X X

CNT_NORMAL X X X X

CNT_WARNING X X X X

CNT_CRITICAL X X X X

CNT_MINOR X X X X

CNT_MAJOR X X X X

MIN_RECEIVE_DELAY X X X X

MAX_RECEIVE_DELAY X X X X

AVG_RECEIVE_DELAY X X X X

TOT_RECEIVE_DELAY X X X X

MIN_AGE_MSG X X X X

MAX_AGE_MSG X X X X

AVG_AGE_MSG X X X X

TOT_AGE_MSG X X X X

CNT_AGE_5_MIN X X X X

CNT_AGE_5_10_MIN X X X X

CNT_AGE_10_30_MIN X X X X

CNT_AGE_30_60_MIN X X X X
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CNT_AGE_60_120_MIN X X X X

CNT_AGE_120_720_MIN X X X X

CNT_AGE_720_1440_MIN X X X X

CNT_AGE_GT_1440_MIN X X X X

CNT_PREV_BUFFERED X X X X

CNT_DUPL_COUNT X X X X

CNT_DUPL_MSG X X X X

CNT_ESCALATE_FLAG X X X X

CNT_AUTO_ACKN_FLAG X X X X

CNT_LOG_ONLY_FLAG X X X X

CNT_NOTIFICATION_FLAG X X X X

CNT_TROUBLE_TICK_FLAG X X X X

CNT_ACKN_AFTER_TT_FLAG X X X X

Metric Hour Day Week Month
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Active Message Property Table

All OVO for UNIX/HPOM for UNIX Active Message summarized data tables are associated 
with the K_OVO_ACT property table.

K_OVO_ACT

Column Name Data Type Population Method

dsi_key_id Maintained by PI

dsi_target_name ON: OVO_SERVER - NODE_NAME 
OS: OVO_SERVER - SERVICE_NAME
OM: OVO_SERVER - MSG_GROUP
ONA: OVO_SERVER – NODE_NAME - 
APPLICATION
ONS: OVO_SERVER – NODE_NAME - 
SERVICE_NAME
ONM: OVO_SERVER – NODE_NAME - 
MSG_GROUP
All Msgs executive summary across all 
messages
A: APPLICATION
S: SERVICE_NAME
M: MSG_GROUP

node_id varchar2(128) Unique ID of node where event occurred.

dsi_status number(3,0) Specifies the global status attribute for the 
managed object. The default value is 2.

dsi_status_time date Contains the timestamp of the last status. The 
default value is the current time.

dsi_table_key Due to custom rollup, all by variables, except for 
GRP_LEVEL and the interval by variable, will 
be concatenated and inserted into 
dsi_table_key

dsi_descr NULL. Not used

GRP_LEVEL Same as dsi_target_name

OVO_SERVER varchar(128) trend_sum populates based on by variable 
“OVO_SERVER”

NODE_NAME varchar(254) 
archar2(2048)

trend_sum populates based on by variable 
“NODE_NAME” 

APPLICATION varchar2(254) trend_sum populates based on by variable 
“APPLICATION”

SERVICE_NAME varchar2(2048) trend_sum populates based on by variable 
“SERVICE_NAME”
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Active Message Data Table

MSG_GROUP varchar2(32) trend_sum populates based on by variable 
“MSG_GROUP”

APPLICATION_ID Number Unique hash for the application

SERVICE_NAME_ID Number Unique hash for the service

OTHER standard 
columns found in PI 
RPs

Column Name Data Type Population Method

Destination Table Rollup Processing Populating Table

SH_OVO_ACT Populated by several roll-up combinations: SH_OVO_ACT.nnn

SD_OVO_ACT Populated by trend_sum using SD_OVO_ACT.sum

SW_OVO_ACT Populated by trend_sum using SW_OVO_ACT.sum

SM_OVO_ACT Populated by trend_sum using SM_OVO_ACT.sum
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Active Message Metrics By Time Interval

Metric Hour Day Week Month

CNT_MESSAGES X X X X

CNT_UNKNOWN X X X X

CNT_NORMAL X X X X

CNT_WARNING X X X X

CNT_CRITICAL X X X X

CNT_MINOR X X X X

CNT_MAJOR X X X X

MIN_AGE_MSG X X X X

MAX_AGE_MSG X X X X

AVG_AGE_MSG X X X X

TOT_AGE_MSG X X X X

CNT_AGE_5_MIN X X X X

CNT_AGE_5_10_MIN X X X X

CNT_AGE_10_30_MIN X X X X

CNT_AGE_30_60_MIN X X X X

CNT_AGE_60_120_MIN X X X X

CNT_AGE_120_720_MIN X X X X

CNT_AGE_720_1440_MIN X X X X

CNT_AGE_GT_1440_MIN X X X X

CNT_CURR_BUFFERED X X X X

CNT_PREV_BUFFERED X X X X

CNT_DUPL_COUNT X X X X

CNT_DUPL_MSG X X X X

CNT_ESCALATE_FLAG X X X X

CNT_AUTO_ACKN_FLAG X X X X

CNT_LOG_ONLY_FLAG X X X X

CNT_NOTIFICATION_FLAG X X X X

CNT_TROUBLE_TICK_FLAG X X X X

CNT_ACKN_AFTER_TT_FLAG X X X X
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Service Log Property Table

All OVO for UNIX/HPOM for UNIX Service Log summarized data tables are associated with 
the K_OVO_SRVLOG property table.

K_OVO_SRVLOG

Service Log Data Tables

The following OVO for UNIX/HPOM for UNIX Service Log rollup tables are used for 
reporting:

Column Name Population Method

dsi_key_id Maintained by PI

dsi_target_name trend_sum populates based on by variable “OVO_SERVER”

dsi_table_key trend_sum populates based on by variable “SERVICE_NAME”

dsi_descr NULL. Not used

OVO_SERVER trend_sum populates based on by variable “OVO_SERVER”

SERVICE_NAME trend_sum populates based on by variable “SERVICE_NAME”

Destination Table Rollup Processing Populating Table

SD_OVO_SRVLOG Populated by trend_sum using the following 
program:
SD_OVO_SRVLOG.sum

SW_OVO_SRVLOG Populated by trend_sum using the following 
program:
SW_OVO_SRVLOG.sum

SM_OVO_SRVLOG Populated by trend_sum using the following 
program:
SM_OVO_SRVLOG.sum
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Service Log Metrics by Time Interval

Metric Day Week Month

CNT_MESSAGES X X X

DURATION_TOTAL X X X

DURATION_UNKNOWN X X X

DURATION_NORMAL X X X

DURATION_WARNING X X X

DURATION_CRITICAL X X X

DURATION_MINOR X X X

DURATION_MAJOR X X X
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B PI Report Packs
Business Technology Reporting Solution

Application Server • Application Server Report Pack
— WebLogic SPI
— WebSphere SPI

Database SPI • Database Report Pack

HP Business Process Insight • BPI Report Pack

HP Internet Services • Internet Services Report Pack

HP Network Node Manager • NNM Event & Availability Report Pack

HP Service Desk • Service Desk Report Pack
• Change Management Report Pack
• SLM Integration Report Pack

HP Sitescope • Sitescope Report Pack

IP Telephony • Cisco IP Telephony Call Detail
• Cisco IP Telephony Gateway Statistics

MPLS VPN • MPLS VPN Report Pack

Networking Traffic Profiling

• RMON II
• NetFlow Interface
• NetFlow Global View
• IP QoS Report Pack
• Class-Based QoS Report Pack

Quality Assurance

• Cisco Ping 
• Service Assurance
• IP Access Rate

Infrastructure Usage

• Interface Reporting
• Device Resource
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Networking (con’t) LAN/WAN Edge

• Frame Relay (SNMP only) 
• ATM (SNMP only)

WAN Core

• Frame Relay (multiple switch vendors)
• ATM (multiple switch vendors)

System Resources • System Resource Report Pack

Business Technology Reporting Solution
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C Message Types for HPOM 9.0
The following table lists the message types available in HPOM 9.0 

Message Source Type Message Source Type Name

1 Console

2 Message

4 Logfile

8 Monitor

16 SNMP Trap

32 ECS

256 Schedule

512 Adv. Monitor

1024 WBEM

2048 WMI

8192 Serv. Dist. 

16384 Node Info

32768 Mgr. Conf.

65536 Config File

69632 Subagent

4096 Internal

Any other code Unknown
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Index
A
Add Database Wizard, 22, 23

C
CD containing report packs

extracting packages, 18

Common Property Tables
upgrade rules, 19
upgrading, 17

Copy Policy Manager, 42

D
Daily_OVO_ACT_Rollup.pro file, 43

Daily_OVO_CONFIG_Rollup.pro file, 43, 44

Daily_OVO_MSG_Rollup.pro file, 43

Daily_OVO_Rollup.pro file, 33

Daily_OVO_SRVLOG_Rollup.pro file, 43, 44

demo package, 16
installing, 18

E
export program

database parameter, 30
datadir parameter, 30
dataset parameter, 30
debug parameter, 30
help parameter, 30
prevdays parameter, 30
server parameter, 30
testing, 31
version parameter, 30
v parameter, 30

export views, 28

extracting packages from distribution CD, 18

I
installation of report pack, 18

L
LIR configuration, 41

O
OVO_Datapipe_Daily.pro file, 33

OVO_Datapipe_Hourly.pro file, 33, 34

ovou7servers.prp, 27, 29

ovou8servers.prp, 27, 29

P
Package Manager, 19

package removal, 38

PI Timer
restarting, 19
stopping, 18

process files
Daily_OVO_ACT_Rollup.pro, 43
Daily_OVO_CONFIG_Rollup.pro, 43, 44
Daily_OVO_MSG_Rollup.pro, 43
Daily_OVO_Rollup.pro, 33
Daily_OVO_SRVLOG_Rollup.pro, 43, 44
OVO_Datapipe_Daily.pro, 33
OVO_Datapipe_Hourly.pro, 33, 34

R
removing packages, 38

report pack CD
extracting packages, 18

reports
active message reports, 45
configuration reports, 93
deploying, 19
history message reports, 63
uninstalling, 38

S
systems.xml, 27, 29

T
trendtimer.sched file, 33, 42
  129



U
uninstalling report pack, 38

upgrading Common Property Tables, 17
rules, 19
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We appreciate your feedback!

If an email client is configured on this system, by default an email window opens when you 
click on the bookmark “Comments”.

In case you do not have the email client configured, copy the information below to a web mail 
client, and send this email to docfeedback@hp.com

Product name:

Document title:

Version number:
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